Arbeiten mit

dem QuadToneRIP

Der QuadToneRIP-Set ist ein von Roy Harrington entwickelter Satz von
Anwendungen, mit dem QuadToneRIP als wesentliche Komponente. Der
QuadToneRIP - oder kurz QTR - ist auf die Erstellung von Schwarzweifs-
Drucken auf einer Reihe von Epson-Fine-Art-Druckern ausgelegt. Der
Satz an Anwendungen - ausschliefSlich mit englischsprachiger Oberfliche -
kann fiir folgende Aufgaben verwendet werden:

Einsatz als Druckertreiber fiir Schwarzweifddrucke mit den Standard-Farbtinten von
Epson unter Verwendung spezieller Monochrom-Profile,

Einsatz mit speziellen Carbon-Tinten auf verschiedenen Epson Druckern
fiir Schwarzweif$drucke,

»QT-Create-ICC-Profilec zum Erstellung von Monochrom-ICC-Profilen - so-
wohl zum Drucken mit dem QuadToneRIP als auch zum Softproofing auf
dem Bildschirm. Diese Monochrom-Profile kénnen auch fiir die Drucker
anderer Fabrikate (Canon, HP, ...) verwendet werden. Die Targets miis-
sen dann aber auf diesen Druckern ausgegeben werden.

»Print-Tool<ist eine kleine Druckanwendung, welche verschiedene Druck-

funktionen anbietet (etwa auch eine Druckausgabe ohne ein Farb-
management, um Targets fiir eine Profilierung auszugeben) als auch das
Layout von mehreren Bildern auf einer Seite. Es ist also eine klassische
kleine Druckanwendung.

Der Satz an Programmen und Dokumentationen enthdlt weitere Kompo-
nenten, etwa Testmuster, die man fiir die Erstellung von SchwarzweifS-ICC-
Profilen benditigt.

Eine inzwischen hdufiger genutzte Anwendung des QTR-RIPs besteht

darin, Schwarzweif$-Negativ-Drucke zu erstellen (auf transparenten
Medien), die dann dazu genutzt werden, um tiber Kontaktverfahren auf
Fotopapier »Drucke« zu erstellen, die dann in bekannter, traditioneller
Nass-Technik entwickelt werden. Dieses spezielle Thema wird nachfolgend
aber ausgeblendet.



Den QuadToneRIP finden Sie im Internet

unter: www.quadtonerip.com
Beschrieben wird hier Version 2.8 aus
dem Jahr 2021 unter macOS
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Den QuadToneRIP (kurz QTR) - den eigentlichen RIP - gibt es fiir macOS
und fiir Windows. Wihrend QTR auf dem Mac wie ein Druckertreiber fun-
giert, ist QTR auf Windows ein Satz von Batch-Programmen, die wir iiber
den Standard-Windows-Druckertreiber ausgeben. Urspriinglich war das
Handling auf Windows weniger elegant, aber die grafische Oberflache seit
Version 2.3 hat die Benutzerfreundlichkeit wesentlich erhoht.

QTR-Paket (s. Abb. [1]) ist Shareware und fiir ca. 50 Euro bzw. USD 50
recht giinstig (ohne Print-Tool). Handbuch, Oberfldche und die verschie-
denen Zusatzdokumentationen sind englisch. Sie konnen ihn unter {2} aus
dem Internet runterladen und vor dem Kauf testen. Das Programm-Set be-
steht, wie in der Einleitung erwidhnt, aus einer Reihe von Programmen, mit
dem eigentlichen RIP wesentliche Funktion.

Eine recht niitzliche Funktion des QTR-Pakets besteht darin, dass man
mit der Komponente QTR-Create-ICC Schwarzweiflprofile fiir ein Soft-
proofing auf dem Bildschirm erstellen kann. Dies ist in knapper Form im
Kapitel 7.6 meines Buchs >Fine Art Printing fiir Fotografen< {1} beschrieben.

QTR ist spezialisiert auf den Schwarzweif3druck. Er unterstiitzt kein
PostScript, sondern lediglich TIFF - unkomprimiert oder LZW-kompri-
miert in RGB oder Graustufe (Grayscale) - ist damit aber sehr schlank und
einfach. Druckt man Farbbilder, so konvertiert QTR diese automatisch vor
der Ausgabe intern nach Schwarzweif3.

Das Paket unterstiitzt eine Reihe von Epson-Druckern (Desktop ge-
nauso wie Grofformat) mit mehreren verschiedenen Tintensitzen (z.B.
UltraChrome, UltraChrome K3, Neutral K7, QuadBlack und UltraTone).
Das Paket schlief3t einige zusétzliche Tools fiir eine Schwarzweif3-ICC-
Profilierung mit ein, die mit Standard-ICC-Tools nicht so einfach ist. Sie
bendtigen dafiir aber ein Spektralfotometer.

Um die nicht ganz trivialen Anleitungen zum QTR-Paket mit seinen
unterschiedlichen Komponenten verstehen zu konnen, sollte man aber
schon brauchbar Englisch beherrschen sowie ausreichend Know-how zu
den verschiedenen Tinten sowie zur Erstellung von Farbprofilen. Fiir letz-
teres wird auch ein unterstiitztes Farbmessgerat (oder ein Scanner) beno-
tigt. Es werden auch nicht alle aktuellen Fine-Art-Drucker von Epson mit
dem QT-RIP unterstiitzt. Schauen Sie sich deshalb vor dem Download die
Reihe der unterstiitzten Drucker und eventuell einzelne Restriktionen an.

Installation

Da QTR iiber ein Installationsskript verfiigt, erfolgt die Installation schnell
und einfach. Der Treiber wird nicht sofort in der Druckerliste angezeigt,
sondern muss zunachst (wie unter macOS iiblich) explizit iiber Drucken ¢
Faxen unter den Systemeinstellungen als zusdtzlicher Drucker angelegt
werden - je einer fiir die verwendeten Drucker. Dort wihlen Sie dann den
Epson-Drucker aus (der schon installiert und online sein muss), den Sie fiir
den Schwarzweif3druck benoétigen, und selektieren im Menii Verwenden


http://www.quadtonerip.com
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(siche Abb. [2] ®) zunichst auf Software auswdhlen. In der & ® Hir 1l ey

erscheinenden Liste gehen Sie nun auf den Eintrag Quad- i‘ @ =

ToneRip xxx (xxx ist die Versionsnummer). Geben Sie dem oo & e S

Drucker unbedingt den Namen »>Quads, gefolgt vom Drucker-

typ, so wie er im QuadToneRIP-Eintrag benannt ist (z.B. r— -

QuadP8oo, falls Sie einen Epson SC-P80oo ansteuern méch- EFBON BI-5820 daries Baries

ten). Anschlieflend miissen Sie noch die passenden Farb- :f:",:;ﬂt:mﬂm m.‘tﬁ

profile installieren bzw. aktivieren. Dazu gehen Sie (unter ) Prinkng FC-PROELHcRUPE S Bk

macOS) in das QuadToneRIP-Progammverzeichnis, dort in

den Unterordner Profiles/xxx/ (xxx ist der Name Thres Dru-

ckertyps) und aktivieren durch Doppelklick das Profilinstalla- Plaar: | SusdmRo0

tionskommando (in unserem Beispiel InstallP80o.command). Srandon:

Damit ist Thre Installation abgeschlossen. Verwenden: OusdTone®P 2.3 Eoson P800 (O
Von nun an kénnen Sie QTR wie einen reguldren Dru-

ckertreiber benutzen, wenn Sie aus einer Anwendung wie Hintiflgen

Photoshop oder Lightroom Classic drucken. Das Kiirzel yUC«
steht in den verschiedenen Zusammenhingen hier fiir die
Epson UltraChrome K3-Tinten und >UC-HD« z.B. fiir dje UndwahlensiedarinihrDruckermodell aus.
HD-Variante, wie sie vom SC-P8oo verwendet wird. Machen

Sie sich nun im QTR-Online-Handbuch” mit den Abkiirzung fiir die Tin-  * Eswird im QTR-Paket als PDF mitgeliefert.
ten des von Thnen eingesetzten Tinten-Satzes vertraut. Die Bezeichnungen

weichen etwas von denen ab, die Epson verwendet.” ** Sie bendtigen dies, wenn Sie im QTR-

[2] Selektieren Sie>QuadToneRIP<in derVerwenden«-Liste

Druckertreiber die Tinten und Tonwerte
Drucken mit QTR unter macOS fir Ihren Druck unter den Kurven wahlen
Wir nutzen in diesem Beispiel Photoshop zum Drucken und iiberlassen = mochten (s. Abb. [7], Seite 4).
hier bei Schwarzweifldrucken das Farbmanagement dem Druckertreiber
(Abb. [3]). In den Einstellungen des Druckertreibers ist unter dem Reiter
Farbanpassungen bereits QuadToneRIP eingestellt.
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Deuscine
Deucier: | OTR-sc-Pa00-2

Yooy Suedrte ot eiurgen

LE ]
Papformat. 04 A4 B om0

Fuberonass—g E
Coblyrg 5 Cnasad Trwmilin
nowkiturn

) n Drimin morbie~San A e e

[5] Im Treiber ist beim QTR bereits QuadToneRIP fur die Farban-

passung eingestellt.
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Unter Druckeroptionen (Abb. [4]) wéhlen Sie unter Media
Type die Papierart (Matte Paper oder Glossy Paper).

Jetzt (noch in den Treibereinstellungen) gehen Sie zum
Reiter QuadTone RIP (Abb. [7]). Hier nehmen Sie Einstel-
lungen fiir Thren Schwarzweifidruck vor. Einige der Ein-
stellungen (z.B. Paper Feed, Resolution, Speed) kennen Sie
schon aus Threm Epson-Druckertreiber, auch wenn sie hier
in Englisch erscheinen. Der Rest sei hier kurz erldutert.

Unter Mode ® wird der Ubergabemodus eingestellt.
Neben den iiblichen 8 Bit stehen hier auch 16 Bit zur Ver-
fiigung (sofern die Bilddaten als 16-Bit vorliegen und die An-
wendung diese iibergeben kann). Den Modus QuadTone RIP
Calibration (unter Mode) wird setzt man ein, wenn ein Test-
muster zur Erstellung eigener Kurven ausgegeben werden
soll. Wir gehen hier nicht darauf ein; es wird aber im Manual
erlautert.

Die wichtigsten Einstellungen erfolgen unter Curve ®.
Hier lassen sich bis zu drei Tonwertkurven wihlen. Man
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[7]1 Unter den Treibereinstellungen zum QT-RIPs setzen Sie |hre aktuellen

Einstellungen fur den Schwarzweil3druck.
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muss hier minimal die Tinte fiir die erste Kurve festlegen. Auch die Papier-
art bzw. das Papierprofil wird iiber den Namen der Kurve mit ausgewiahlt.
HMBaryta geht etwa von einem Baryt-Papier aus. Die Namenskomponente
»smk¢ steht fiir die matte Schwarztinte (Matte Black), >pk« fiir Photo Black
(Fotoschwarz). Die Kurven stellen unterschiedliche Farbkurven dar, etwa
eine warmtonige und (oder) eine eher kalttonige Kurve. In der Regel findet
man vier Kurven: Cool (kiihl), Neutral, Sepia und Warm.

Mehr als eine Kurve muss man nur dann auswahlen, wenn man die
Option Split-Tone © nutzen mochte, um Tiefen (Shadows), Mitteltone
(Midtones) und (oder) die Lichter (Highlights) unterschiedlich zu ténen.
Unter den entsprechenden Rubriken ldsst sich dann der Anteil der jeweili-
gen Kurve (und damit des Farbtons) tiber die Schieber einstellen. Der
Treiber stellt dabei automatisch sicher, dass immer die Summe von 100 %
(jeweils fiir Lichter, Mitteltone und Tiefen) eingestellt ist. Auf diese Weise
lasst sich der Farbton des Drucks sehr fein und nach dem eigenen Geschmack
in den verschiedenen Tonwertbereichen einstellen. Einige Testdrucke sind
aber dafiir zu Beginn sicher notwendig, bis man ein Gefiihl fiir die verschie-
denen Kurven und die damit erzielten Ténungen bekommt.

Im Menii Paper Feed (Abb. [7] ®) wird festgelegt, tiber welchen Papier-
pfad das Papier eingezogen wird. Die moglichen Einstellungen - etwa Roll
Feed fiir Rollenpapier - sind hier auch abhiangig vom eingesetzten Drucker.

Eine Art Qualititseinstellung erfolgt tiber das Resolution-Menii ®,
wihrend man unter ® iiber das Speed-Menii zwischen dem unidirektiona-
len und dem schnelleren bidirektional Druck wahlen kann. Bei heutigen
Druckern kann man ohne sichtbare Qualitdtsverluste Bi-directional nut-
zen.

Die Funktion Black Ink steht nur bei einigen Druckern zur Verfiigung;
sie erlaubt anzugeben, ob mit Photo Black oder mit Matte Black bzw. der
aktuell gerade installierten Tinte gedruckt werden soll. Beim Drucken mit
den Epson-Tinten sollte man hier fiir das verwendeten Papier optimierte
Scharztinte wéhlen — Photo Ink fiir glinzende Medien und Matte Ink fiir
matte Medien.

Aktiviert man Advanced Adjustments (Abb. [7] @), so ldsst sich zusitz-
lich die Tintenmenge iiber den Ink Limits-Regler justieren - etwa um bei
einem weniger saugenden Papier zu verhindern, dass Tinte darauf stehen
bleibt. Der Gamma Regler gestattet das Gesamtbild in den Mitteltonen et-
was authellen oder absenken, ohne dass deshalb die Bilddatei gedndert
werden muss. In der Regel beldsst man ihn aber bei Null.

Unter @ Dither lassen sich zusitzlich unterschiedliche Dithering-Ver-
fahren auswiéhlen. In aller Regel bleiben wir hier bei Ordered. Es sei aber
zum Experimentieren ermuntert.

wock s (T

Makto Ink
Fhioto Ink

[8] Hierkdnnen Sie bei Bedarf festlegen, mit

welcher Schwarztinte gearbeitet werden soll.
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[9] QTR bietet mehrere Ver-

fahren fur das Dithering an.
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Drucken mit QTR unter Windows

Hier nur das Konzept in Kiirze, da ich hier keine erschépfende Beschreibung
geben mochte. Die meisten Einstellungen erkldren sich von selbst oder wer-
den in GTRGui Help und im User guide, welches man unter dem Help-
Ment findet, erldutert. Die meisten Funktionen entsprechen denen des
QTR-Treibers unter macOS.

Unter Windows lduft QTR nicht als Treiber, sondern als normale An-
wendung, welche die Daten/Bilder iiber den Standard-Windows-Treiber
fiir den entsprechenden Drucker ausgibt. Seit QTR 2.3 gibt es eine benut-
zerfreundliche grafische Oberfliche namens QuadTone RIP Graphical
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Interface (QTRgui). Legen Sie QTRgui in die Windows-Quickstart-Leiste.
Wenn Sie Ihre eigenen Gradationskurven generieren wollen (z. B. fiir neue
Tinten oder Papiere), installieren Sie ebenfalls den Curve Creator.

Zu Beginn hat man in QTRgui (Abb. [10]) unter View »Skins die Wahl
zwischen unterschiedlichen Oberfldchen (Skins). Ich habe hier Default ge-
wihlt. Unter Tools» Options lassen sich einige Optionen einstellen, etwa
den Auto-Print-Modus per Drag & Drop. Einmal gemachte Einstellungen
lassen sich unter View » Presets » Manage presets hinterlegen und danach
unter View » Presets abrufen.

Unter ® stellt man zunéchst den Zieldrucker und als Printing-Modul
das zu IThrem Drucker passenden QTR-Modul ein (Abb. [11]).

Uber einen kleinen Datei-Browser, den man iiber die Meniifolge
File»Select Image aufruft, lassen sich Bilder fiir den Druck auswihlen.
Alternativ kann man eine Datei per Drag &Drop in das kleine Vorschau-
fenster (Abb. [10] ®) ziehen. Ein Klick auf Print stofit dann den Druck an
(sofern nicht unter den Optionen der automatische Druck aktiviert ist).

QTR bietet hier einen tiberwachten Hot-Folder. Diesen legt man unter
Tools»Monitor Folder fest. Kopiert man Dateien in diesen Ordner, so
werden sie automatisch in die Druckauftragsliste iibernommen.

QTR kann unter Windows nur TIFFs drucken (Graustufen oder RGB,
unkomprimiert oder LZW). Es verarbeitet die meisten TIFF-Versionen, die
Photoshop erstellen kann.

Eine Stirke des QTR-Programm-Sets liegen in der Moglichkeit, Schwarz-
weiflprofile anzulegen und eine Linearisierung fiir den Drucker (in Kom-
bination mit Tinte und Papier) zu erstellen. Daneben bietet QTR Unter-
stiitzung von verschiedenen Fremdtintensdtzen (Schwarz-/Grautinten),
die vom Epson-Treiber nicht unterstiitzt werden.

Mehr Details tiber die Profilierung der Linearisierung und der An-
passung von Gradationskurven finden Sie in verschiedenen QTR-Tutorials
und Hilfe-Dokumenten - leider alle englischsprachig. Zusitzlich findet
man Hilfe in der Yahoo-Gruppe (englischsprachig) unter der nebenstehen-
den URL.

Das Print-Tool

Was in der QTR-Sammlung fehlt, ist eine Druckanwendung, welches es er-
laubt mehrere Bilder auf einer Seite (oder auf mehereren Seiten) zu platzie-
ren. Hierfiir gibt es das Print-Tool - allerdings nur unter macOS. Es muss
(nach einer Testperiode) separat (im Download) fiir etwa 39 Euro lizenziert
werden. Die Oberfliche ist recht iibersichtlich, wenn vom Aussehen her et-
was altbacken - und natiirlich englisch (s. Abb. [12]). Man kann damit aber
nicht nur mit dem QT-RIP drucken, sondern mit praktisch allen installier-
ten Druckertreibern. Eine Besonderheit besteht darin, dass man damit ein
Bild auch ohne Farbmanagement (durch das Betriebssystem oder die An-
wendung) drucken kann, was notwendig ist, wenn man Targets fiir eine
Drucker-Profilierung ausgeben mochte. Man stellt dies im Menii zu ® ein.

[T 5 EFSORF CHAS (P00 T N
o N
[11] Wahlen Sie zundchst den Zieldrucker

und das passende QTR-Druckmodul (hier
QuadP800 fur den SC-P800).

QTR-Yahoo-Gruppe: http://groups.yahoo.com/
groupQuadtoneRIP


http://groups.yahoo.com/groupQuadtoneRIP
http://groups.yahoo.com/groupQuadtoneRIP
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[12] Das Fenstervon Print-Tool. Es skaliert schlecht — insbesondere das linke Fenster mit dem Seiten-Layout, ist ansonsten aber Gbersichtlich.

Doch von vorne. Zunichst wihlt man ® unter Printer den gewiinschten
Zieldrucker und unter ® Page Setup das Ausgab-/Papierformat. Rechts
oben lassen sich die Einheiten fiir die verschiedenen Mafle wihlen (Inches,
cm, mm, Points, Picas). Dann sieht man das Format unter © das Seitenformat
und darunter deren Grofle sowie die Riander (hier nicht einstellbar).

Die nichste Icon-Leiste bezieht sich auf die Darstellung der Seiten-
vorschau ®, die hier (etwas) skaliert, gedreht und mit einem Raster verse-
hen werden kann. Das Magnify-Feld zeigt die aktuelle Skalierung der
Vorschau an (und ist kein Eingabefeld).
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Im Teilfester ® sieht man die platzierten Bilder aufgelistet. Mit dem
+-Icon lasst sich ein weiteres Bild hinzufiigen, wozu ein kleiner Datei-
Browser fiir die Auswahl erscheint. Alternativ lassen sich Bilder auch per
Drag&Drop in das Vorschaufesnter ziehen oder man aktiviert iiber die
Meniifolge File» Open Image... wieder einen Datei-Browser fiir die Aus-
wahl. Print-Tool ist dabei etwas wihlerisch, welche Bildformate es akzep-
tiert. Es sind JPEG, TIF, PSD, PNG und GIF in 8- und 16 Bit — akzeptiert je-
doch keine ZIP- und LZW-Komprimierung. Uber das Minus-Icon 18scht
man den in der Liste selektierten Eintrag bzw. das betreffende Bild.

Das in der Liste ® ausgewiéhlte Bild lasst sich iiber die Eintrige unter
Position and Scaling feiner positionieren und Skalieren und bei Bedarf
Rotieren sowie bei iiberlappenden Bildern iiber Top und Bottom in der Sta-
pelreihenfolge verschieben. Im Bereich ® zeigt die Anwendung die Gréfie
in Pixel sowie die Farbtiefe und daneben das Quellprofil eines selektierten

Bild an.
Im unteren Block legen wir die Details zum Drucken fest. Das Ment @ [+ Priet-tocs varwgea VAL
erlaubt dabei vorzugeben, wie das Farbmanagement erfolgen soll (Abb. [13]) Mo Golor Managaman Festlegung zum

- und rechts davon, ob der Epson ABW-Modus (Advanced Black ¢ White Prink Driwer Wanaged
bzw. SchwarzweifS-Foto erweitert) des Epson-Drucker
verwendet wird, was nur bei Druckern mit dieser
Funktion funktioniert. Fastathve inbent © [13] Diese Umsetzungspriorititen

Beim Farbmanagement durch das Print-Tool wih- :::"_:“_..“I,:w (Intents) werden geboten. BPC steht
len wir unter ® das Farbprofil fiir die Farbumsetzung — dabei flir Black Point Compensation (
und unter @ die Umsetzungsprioritit (Abb. [13]).

Unter @ lasst sich ein Softproofing aktivieren. (Es gibt offensichtlich zahl-
reiche Varianten Softproofing zu schreiben).

Mochte man das Bild als »digitales Negativ< drucken, aktiviert man Proc + lak Black
Option ® Negative und wihlt dann iiber den Knopf Prefs..., wie das ge-
schehen soll (s. Abb. [16]).

Unter © kénnen wir schliellich wihlen wie das
Bildan den Druckertreiber iitbergeben wird. Unterstiitzt PRINT
dieser 16 Bbit, sollte man dies wéhlen. TOOL |

Ist alles fertig, stofft man iiber ©® Run Print... das =
Drucken an. Es erscheint damit nochmals der Treiber-

dialog des Betriebssystems und bei Bestatigung werden Beckground | ﬂ H H b I H H
#rain g (TR e

Farbmanagement

0 ks Salr Prosling [5]
Print-Tool erlaubt

ein Softproofing

P Tood Pealergraas

it sl Majitiees

Yo
die fertigen Seiten an den unter ® eingestellten Dru-
ckertreiber tibergeben.

Blha'w  Bordde ol

Fligi B Efaskiod St -« Tl Shviarh Orily &8 Theb 11 om

Insgesamt ist Print-Tool ein nettes kleines Werkzeug,
kommt aber nicht ganz an die Mdglichkeiten anderer
RIP-s und Druckanwendungen (wie etwa ImagePrint
von ColorByte Software, Mirage Pro von DINAX oder
Printao von Lasersoft Imaging) heran. Es kann fiir Epson-Drucker preis-
glinstiger durch das kostenlose Epson Print Plug-in und fiir Canon-Drucker
durch Print Studio Pro ersetzt werden - oder durch Lightroom Classic.’

[16] Diese Einstellungen sind nur fir die Ausgabe als »digitales

Negativ<von Interesse.
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Die gleiche Anwendung, nun von Calibrite {6}

angeboten, nennt sich ccProfiler.

Arbeiten mit dem QuadToneRIP

Fazit

Insgesamt ist das QuadToneRIP-Programmpaket, von dem hier nur die
Treiber-Komponente beschrieben wurde, ein schone und mit etwa so Euro
preiswerte Losung fiir den Schwarzweifidruck auf den unterstiitzten
Druckern. Sowohl die Installation des Pakets als auch der RIP und die an-
deren Komponenten erfordert aber etwas Zeit fiir die Einarbeitung und das
Studium der verschiedenen Anleitungen, die man iiber die Links auf der
QTR-Seite und anderswo im Internet findet. Dies gilt vor allem, wenn man
auch die weiteren Funktionen des QTR-Pakets nutzen mochte, wie etwa die
Erstellung eigener Profile und die Linearisierung von Profilen. Die origi-
nédre QTR-Anleitung geht dabei noch von der Nutzung des Messkopfs i1Pro
1 mit der Software ProfileMaker 5 aus, die aber veraltet und nicht mehr ver-
tiigbar ist. Es gibt aber auch Losungen mit anderen Mitteln — etwa dem
i1Pro-2-Kopf und der aktuellen X-Rite-Software i1Profiler’ oder einem (ka-
librierten) Scanner oder dem X-Rite Color Munki Photo-Kit oder ...

Der Grofiteil dieser Dokumentation ist englischsprachig und in relativ
vielen Dokumenten verstreut. Hier wiirde man sich eine zusammenfas-
sende Dokumentation an einer Stelle wiinschen. Dies ist eben ein Nachteil
der sehr preiswerten Shareware-Lésung. Einige Hinweise und alternative
Patches findet man (englischsprachig) auf der Internetseite des sehr regen
Keith Cooper unter {3}.

Auch die fiir den QTR erstellten Schwarzweifl-Profile fiir verschiedene
Drucker und zahlreiche Papiere sind im Internet recht verstreut. Die meis-
ten der Profile (und einige andere Hilfsmittel) sind kostenlos, fiir andere
tallt ein Obolus an.

Was in der QTR-Dokumentation verwirrt ist die Verwendung des Be-
griffs Profil. In einige Fillen ist damit wirklich ein ICC-Profil gemeint, oft
aber eine Art Tinten-Papier-Einstellung, wofiir teilweise synonym auch
der Begrift Kurve(n) vorkommt. Hier mag die englische Beschreibung von
Richard Bowell unter {5} etwas Klarheit schaffen (englischsprachig).

Da sich der QTR-Treiber (zumindest unter macOS) fast wie ein norma-
ler Druckertreiber funktioniert, lasst sich damit nicht nur aus Photoshop
heraus drucken, sondern ebenso aus Lightroom Classic oder fast jeder an-
deren Anwendung, die das Drucken von Bildern unterstiitzt.

Schade ist, dass meines Wissens der eigentliche QT-RIP bisher nur
Epson-Drucker unterstiitzt. Die Profilierungskomponente QT-Create-
ICC-Profile.app hingegen kann auch Monochrom-ICC-Profile fiir Drucker
von HP und Canon oder anderen Anbietern erstellen, sofern man die
Grauton-Targets auf dem betreffenden Drucker (bei deaktiviertem Farb-
management) ausdruckt, vermisst und die Messwert der App vorwirft.

Ganz auflen vor habe ich hier die Werkzeuge zur Erstellung von
Schwarzweif3-ICC-Profilen und der >Kurven-Profile« sowie die Werkzeuge
zur Linearisierung von >Kurven« und »>Profilen«. Ich habe auch keine
Erfahrung mit Carbon-Tinten auf einem Epson-Drucker und dieses Thema
deshalb ignoriert.



Arbeiten mit dem QuadToneRIP

Literaturangaben und Links

Hier finden Sie einige der in diesem Dokument aufgefiihrten Werkzeuge
und einige Empfehlungen fiir weiterfithrende Literatur geben. Bei Internet-
adressen ist zu berticksichtigen, dass sie sich zuweilen kurzfristig dndern,
eine andere URL erhalten oder ganz verschwinden. ™= signalisiert, dass die
Quelle oder das Programm englischsprachig ist, 4¥, dass es fiir Windows,

& fiir macOS zur Verfiigung steht.

{1}  Jurgen Gulbins, Uwe Steinmiiller: Fine Art Printing fiir Fotografen.
Hochwertige Fotodrucke mit Inkjet-Drckern. (6. Auflage)
Print: 978-3-86490-956-6
PDF: 978-3-96910-942-7
dpunkt.verlag, Heidelberg, 2023

{2}  Roy Harrington bietet den QuadTone RIP (%=, i, &%) als Shareware
an. Das Paket kostet etwa 50 USD. Der RIP ist fiir das Drucken in
Schwarzweif auf Epson-Fine-Art-Druckern ausgelegt. Das RIP-Paket
erlaubt aber zusitzlich die Erstellung von Schwarzweif3-Softproof-
Profilen: www.quadtonerip.com

{3}  Northlight Images: Keith Cooper unterhalt hier eine sehr gute Intern-
setseite (™=)zu Themen rund um die digitale Fotografie und insbe-
sondere zum Drucken mit Inkjet-Druckern. Hier findet man teilweise
sehr ausfithrliche Reviews zu Druckern und Papieren und ebenso zm
Linearisieren von ICC-Profilen:
www.northlight-images.co.uk

{4} Eine der wenigen deutschsprachigen Beschreibungen zum Quad-
ToneRip bei der Verwendung mit einem Epson Stylus Photo 2100 von
Dieter Walter:
https://www.d-walter-photo.de/Neue_Dateien/Perfekte%20SW%20
Drucke/QuadToneRIP.html

{s}  Richard Bowell - Black & White Mastery (®=): Hier finden Sie ein
ganze Reihe von Informationen zum QuadToneRIP, zu Kurven und
anderen Dingen sowie zur Erstellung von »digitalen Negativenc.

Richard vermarktet auch einige erweiterte Werkzeuge fiir Schwarz-
weifldrucke sowie die Erstellung und Linearisierung von Kurven

(Profilen): https://www.bwmastery.com

{6} Calibrite hat2021die eher Consumer-orientierten Komponenten
der Firma X-Rite ibernommen und vertreibt und entwickelt sie
nun unter diesem Namen weiter — zumeist mit etwas geindertem
Produktnamen. Hier finden wir Produkte wie ColorCheckr Passport,
ColorCheckr Display und ColorCheckr Studio:
https://calibrite.com/de/
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